Excel 2013 Tips and Tricks

Contents

1. Useful Keyboard Shortcuts ................................................................. 2
2. Jumping to a Specific Worksheet.......................................................... 2
3. Assigning Colours to Worksheet Tabs ...................................................... 3
4. Entering Same Data into Several Worksheets in One Go.......................... 3
5. Selecting Parts of a Worksheet .................................................................. 3
6. Selecting a Large Range Via Name Box .................................................. 4
7. Use the Extend Selection Mode ................................................................. 4
8. Repeat the Most Recent Action ............................................................... 4
9. Moving/Copying Without the Clipboard .................................................. 5
10. AutoFill ................................................................................................. 5
11. AutoCalculate for Quick Totals .............................................................. 7
12. Naming Cells to Help with Navigation and Selection of Ranges ............... 7
13. Page Layout View ................................................................................... 8
14. Quickly Adding a Header/Footer ............................................................ 9
15. Controlling Page Breaks and Scaling in Page Break Preview .................... 9
16. Rearrange Columns ............................................................................... 10
17. Freezing the Top Row or First Column of a Worksheet ............................ 10
18. Splitting a Window to Compare Records ............................................... 11
19. Filter a Table by a Selected Cell’s Value ............................................... 11
20. Hiding Columns/Rows .......................................................................... 12
21. Adding your Favourite Commands to the Quick Access Toolbar .............. 12
22. Flash Fill ............................................................................................... 13
23. Help When Writing a Formula ............................................................... 14
24. Format Painter ....................................................................................... 14
25. Create a Style ........................................................................................ 14
26. Data Bars Conditional Formatting ......................................................... 15
1. **Useful Keyboard Shortcuts**

CTRL+N  
New Workbook (Excel file)

CTRL+TAB  
Move around open Excel windows

SHIFT+F11  
New Worksheet

CTRL+Page Down  
Move to the next Worksheet

CTRL+Page Up  
Move to the previous Worksheet

CTRL+Spacebar  
Select columns (based on current active cell(s))

SHIFT+Spacebar  
Select rows (based on current active cell(s))

CTRL+SHIFT+(+)  
Adds a new row/column (useful to select a row or column beforehand)

CTRL+(-)  
Deletes a row/column (useful to select the row or column beforehand)

SHIFT+Cursor key  
To extend a selection

ATL+=  
Auto Sum command

CTRL+SHIFT+&  
Applies an outline border to the selected cells

CTRL+1  
Shows format cells dialogue box

Alt+ENTER  
A new line in a cell, i.e. insert a line break

CTRL+0 (zero)  
Hide current column

CTRL+9  
Hide current row

CTRL+SHIFT+9  
Unhide current row

F11  
Create a chart in a separate workbook

F12  
Save As


2. **Jumping to a Specific Worksheet**

One option that works well if you have a large number of worksheets (say, up to 30-40 sheets or less) is to right click the sheet navigation buttons at the left of the sheet tabs.

Doing so will open a dialogue box which displays a list of worksheet names, as shown opposite. Click on the one you wish to jump to.
3. **Assigning Colours to Worksheet Tabs**
   i. Right click a worksheet tab and select **Tab Colour** from the drop down menu.
   ii. Select a colour from the list available or click on **More Colors** for further options.

   **NOTE:**
   Whenever a tab is selected its background becomes white. In the case of a coloured tab, when it is selected the colour will be reduced to a coloured line under the tab name.

4. **Entering Same Data into Several Worksheets in One Go**
   i. Click on the first worksheet tab
   ii. Hold down **CTRL** and click on the additional worksheet tabs in turn. (Use click and **SHIFT-Click** if you wish to select a series of adjacent worksheets)
   iii. Start typing and formatting text if necessary. What you type and any formatting will be entered in all selected worksheets
   iv. To deselect click on a tab not selected, or if all were selected click in the worksheet

5. **Selecting Parts of a Worksheet**
   A range: Click in one cell, then hold down the **Shift** key and click in another cell. i.e. perform a ‘**Shift-Click**’
   E.g. Click in cell A1, then Shift-Click in cell C3.
   This range can be referred to as **A1:C3**

   Text in a block: This is very useful when the block of data if very large, i.e. when the data goes on for 100s of rows.
   Click at the top of the block then **CTRL+SHIFT+cursor key**

   Non adjacent ranges: Select the first range, hold down **CTRL** and select the subsequent range(s)

   Whole column or row: Click on the column letter or row number

   More than 1 adjacent column/row: Click and drag through the column letters or row numbers
To extend a selection
More than 1 non-adjacent column/row:
SHIFT+cursor keys
Select the first column/row, hold down CTRL and select the subsequent columns/rows

Whole Workbook:
Click in the very top left corner

Data Set/Whole Workbook
First CTRL+A will select just the data set (the current range of adjacent cells which have data in them)
Second CTRL+A will select the whole workbook

6. Selecting a Large Range Via Name Box
Type the name of the range in Name box and press ENTER.
E.g. A1:D25000

7. Use the Extend Selection Mode
Clicking on the F8 key on the keyboard switches on the Extend Selection mode. This means that you can extend the current selected range one row or one column at a time using the cursor keys. And you can keep extended until you switch off the feature using the F8 key.

8. Repeat the Most Recent Action
If you have just formatted some text or carried out an action it is possible to repeat the same formatting to further text or repeat the last action using the repeat command.

i. Select some text and format it (e.g. bold, font colour or borders), or, carry out an action (e.g. insert a row)
ii. Select the text you wish to repeat the most recent action to or click in another cell
iii. Press the Function key F4 or use the Repeat button on the Quick Access Toolbar

EXTRA TIP: If you select several features from a dialogue box, such as font or paragraph dialogue box, the Repeat command will repeat the multiple features.
9. **Moving/Copying Without the Clipboard**

**Moving Data**

i. Select the cell(s) containing the data you wish to move

ii. Carefully move your mouse pointer over the black outline of the active cell (or range of cells) until the four-headed arrow 'move' symbol appears on the mouse pointer

iii. Now click and drag the cell contents to another cell

**Copying Data**

Repeat the above procedure but this time before you click and drag press and hold down the **CTRL** key. The four-headed arrow 'move' symbol will change to indicate a Plus sign 'copy' symbol. Now if you click and drag to another cell you will have copied the contents.

10. **AutoFill**

AutoFill is a quick and easy method you can use for copying data or formulas. It is also an invaluable tool for filling in a data series, thereby saving you lots of time, for example, when you need to type a sequence of numbers or dates in a column/row.

**Performing an AutoFill**

i. Select the cell which has the text, data or formula you wish to copy or fill.

The active cell will have a small black box in the lower right corner and this is referred to as the **Fill Handle**.

ii. Point the mouse at the fill handle. When the mouse pointer is directly over the Fill Handle it changes to a black cross indicating that you are now ready to click and drag.

iii. Click and drag in the direction required to start filling in values into the cells you are dragging over.

iv. Release the mouse button.
The cells you dragged over are now filled with copies of the text, data or formula, or, a data series such as the days of the week.

**TIP:**
If you hold down CTRL while you drag the fill handle you will suppress any data series filling and ensure simple copying takes place.

**TIP:**
If the column you wish to fill is adjacent to a column which already has data in it, you can double click on the AutoFill handle. This will fill the column to match the length of the adjacent column.

---

**Creating a Data Series with Numbers**

If you wish your data series to be numbers going up in particular increments you can achieve this by typing in two numbers in adjacent cells indicating what increments jumps you require.

Now select both cells and click and drag the Fill Handle down until you have the series you need.

**TIP:**
If you wish to increment by a single number, select the one cell with the starting number, hold down CTRL while you drag.

**TIP:**
If you wish to fill a series only on every other cell in a column, type in your two numbers, each followed with a blank cell, then autofill the four cells.

---

**A summary of examples of creating a data series:**

<table>
<thead>
<tr>
<th>Autofill</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>23 text Jan Chapter 1 Monday Mon 23-Jan 1-Jan</td>
<td>23 text Jan Chapter 1 Monday Mon 23-Jan 1-Jan</td>
</tr>
<tr>
<td>23 text Feb Chapter 2 Tuesday Wed 23-Jan 4-Jan</td>
<td>23 text Feb Chapter 2 Tuesday Wed 23-Jan 4-Jan</td>
</tr>
<tr>
<td>23 text Mar Chapter 3 Wednesday Fri 30-Jan 7-Jan</td>
<td>23 text Mar Chapter 3 Wednesday Fri 30-Jan 7-Jan</td>
</tr>
<tr>
<td>23 text Apr Chapter 4 Thursday Sun 31-Jan 10-Jan</td>
<td>23 text Apr Chapter 4 Thursday Sun 31-Jan 10-Jan</td>
</tr>
<tr>
<td>23 text May Chapter 5 Friday Tue 1-Feb 13-Jan 10-20</td>
<td>23 text May Chapter 5 Friday Tue 1-Feb 13-Jan 10-20</td>
</tr>
<tr>
<td>23 text Jun Chapter 6 Saturday Thu 2-Feb 16-Jan 10-40</td>
<td>23 text Jun Chapter 6 Saturday Thu 2-Feb 16-Jan 10-40</td>
</tr>
<tr>
<td>23 text Jul Chapter 7 Sunday Sat 3-Feb 19-Jan 11-00</td>
<td>23 text Jul Chapter 7 Sunday Sat 3-Feb 19-Jan 11-00</td>
</tr>
</tbody>
</table>
11. **AutoCalculate for Quick Totals**

AutoCalculate can give you a quick answer about a range of cells without you having to write any formulas. For example, you may need to quickly find out what a range of cells adds up to or what the average is of a few cells.

**To Use AutoCalculate**

i. Select the cells you want to include in the calculation. (Hold down CTRL to select non adjacent ranges)

The answers appear on the Status bar. By default you get the Average, Count and Sum of the selected range.

![Calculation example](image)

**TIP:**

If the type of calculate you require is not listed on the status bar you can customize this via the status bar options.

i. Right click anywhere on the status bar

ii. Locate the AutoCalculate options in the lower half of the drop down menu which appears

iii. Make sure there is a tick by the calculations you require and no tick by the ones you do not require. One click will add a tick, another click will remove.

iv. When you are ready click away from the drop down menu and then the calculation you selected will be present on the status bar.

12. **Naming Cells to Help with Navigation and Selection of Ranges**

It is possible to name a cell or a range of cells. You may wish to do this in order to make navigating around the worksheet/workbook easier or to make writing formulas easier. This is especially useful when referring to a cell on another worksheet when you are writing a formula.

This is also useful if you need to frequently select a series of non adjacent cells in order to carry out formatting to them. Selecting non adjacent cells spread out across a large worksheet could take you some time to do. If you give this range a name it will make selecting them much easier and quicker.

**Naming a Cell or Range of Cells**

i. Click on the cell (or select a range of cells)

ii. Click in the Name box
iii. Type in the name and press **Enter**.

   **NOTE:** The name must not have any blank spaces.

**TIP:**
Any cell (or range of cells) can be given more than one name

**TIP:**
Once you have named a range, if you zoom out to 39% or less you will see the named ranges marked on the worksheet as shown opposite

---

**Navigating to (and Selecting) a Named Cell or Range**

To navigate to a named cell or range do one of the following:

- Click on the down arrow after the Name box and select the name you require from the drop-down list
- Press the keyboard shortcut keys **CTRL+G** (or function key F5) to display the Go To dialogue box, select the name you require from the list and click OK.

**TIP:**
It is possible to select more than one name in one go. To do this, select the first name you require from the Name Box arrow drop-down list. Hold down **CTRL** on the keyboard and select further names you require in the same way as the first.

**TIP:**
To display the contents of a single named cell in another cell, type ‘=’ and the name of the range, then press **ENTER**.

**TIP:**
To bring up the list of names, (especially useful when you are in the middle of writing a formula) click on the F5 key on your keyboard.

---

13. **Page Layout View**

You may wish to work in a view where you can clearly see the page margins and any existing header and footer information. This is especially useful if you are preparing a spreadsheet for printing. To do this switch to Page Layout View.

i. Go to the **View** tab and locate the **Workbook Views** group.

ii. Click on the **Page Layout** command button.
Alternatively, click on the Page Layout View button on the status bar.

Notice that the margins, header and footer can be seen as you work.

**TIP:**
To temporarily hide the margins in this view click in the space just outside the page area, e.g. just above the top margin, between two horizontal pages.

**14. Quickly Adding a Header/Footer**

To quickly enter a header or footer, go to Page Layout view (see Tip 15), click over the header or footer area and begin typing.

**TIP:**
To add a header to three worksheets in one go, select the three worksheets (use Shift click or CTRL click) then type in the header.

**15. Controlling Page Breaks and Scaling in Page Break Preview**

If you ever need to view or control the page breaks, whether it’s ones you created or the naturally occurring ones, go to Page Breaks Preview view. To switch this view on either:

i. Click on the Page Break Preview command button
(View tab, Workbook Views group)

Or,

i. Click on the Page Break Preview button on the status bar.
Adjusting the Page Breaks in Page Break Preview

Once in Page Break Preview you may adjust the page break positions by clicking and dragging the blue page break lines with your mouse.

**NOTE:**
If you move the page breaks to allow more columns or rows to fit into one page Excel will compensate by reducing the font size. You may find this helpful at times but at others you may find the altered size of text too small to read.

16. **Rearrange Columns**
This method avoids you having to insert new columns and using cut and paste.

i. Insert a row above the data

ii. Into the new row type in a number into each cell to represent the order you wish the columns to be rearranged into.

iii. From the Data tab, select the Sort command

iv. Click on the Options button and select Sort left to right

v. Select Row 1 in the Sort by field

vi. Click OK

17. **Freezing the Top Row or First Column of a Worksheet**
The freezing panes feature is very useful if you wish to scroll through a worksheet whilst keeping the top row in view all the time. It will only work in Normal view.

_To Freeze Just the Top Row or First column:_

i. Click the Freeze Panes command button (View tab, Windows group)

ii. Select the option Freeze Top Row to freeze only the top row of the worksheet, or, select the option Freeze First Column to freeze only the first column of the worksheet.
To Unfreeze Panes
i. Click the Freeze Panes command button (View tab, Windows group)
ii. Select the Unfreeze Panes option

NOTE: Freezing cells will not affect printing.

18. Splitting a Window to Compare Records
If you split the window into separate panes you will be able to view different areas of a large worksheet at the same time. This will save you constantly having to scroll around your worksheet. You can split a window into two panes either horizontally or vertically. If you split a window both horizontally and vertically you can display four panes.

To Split a Window:
i. Click in the cell just below and/or to the right of where you wish to split the window
ii. Click the Split command button (View tab, Windows group)

NOTE: There are four sets of scroll bars, so you are free to scroll around in each segment.

To Remove the Split
i. Click the Split command button (View tab, Windows group)
Or,
i. Double click on any part of the split line between the panes. You will have to do one double click on the vertical border and one on the horizontal border.

NOTE: Splitting a window will not affect printing.

19. Filter a Table by a Selected Cell’s Value
i. Right click the cell which has the value you wish to filter by
ii. Select Filter from the shortcut menu
iii. Select Filter by Selected Cell’s Value
20. **Hiding Columns/Rows**

This is useful if you wish to print only particular columns or rows.

i. Select the entire row or column by clicking on the row or column heading, for example column C or row 5. If you wish to select a range of columns or rows you need to click and drag the column or row headings to select more than one.

ii. Go to the **Home** tab and locate the **Cells** group.

iii. Click on **Format** command button.

iv. Select the **Hide & Unhide** option.

v. Select either **Hide Rows** or **Hide Columns**.

**Shortcut Tip:**
Alternatively, select the rows/columns you wish to hide by selecting the actual column or row headings, right click the selection and choose **Hide** from the drop down menu.

### Hidden Columns:
- B, C, F

### Hidden Rows:
- 6 – 9 and 12 - 18

**NOTE:**
A double line on the row / column headings indicates where rows / columns have been hidden.

<p>| | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>B</td>
<td>D</td>
<td>E</td>
<td>F</td>
</tr>
<tr>
<td>1</td>
<td>Surname</td>
<td>Town/City</td>
<td>Country</td>
<td>Date of Birth</td>
</tr>
<tr>
<td>2</td>
<td>Ergani</td>
<td>Swansea</td>
<td>Wales</td>
<td>27/2/1950</td>
</tr>
<tr>
<td>3</td>
<td>Reff</td>
<td>Perth</td>
<td>Scotland</td>
<td>27/2/1950</td>
</tr>
<tr>
<td>4</td>
<td>MacDonald</td>
<td>Worthing</td>
<td>England</td>
<td>27/2/1950</td>
</tr>
<tr>
<td>5</td>
<td>Davies</td>
<td>Chichester</td>
<td>England</td>
<td>15/6/1951</td>
</tr>
<tr>
<td>6</td>
<td>Cahill</td>
<td>Penzance</td>
<td>England</td>
<td>15/6/1939</td>
</tr>
<tr>
<td>7</td>
<td>Dultz</td>
<td>Halifax</td>
<td>Canada</td>
<td>24/12/1945</td>
</tr>
<tr>
<td>8</td>
<td>Williams</td>
<td>Swansea</td>
<td>Wales</td>
<td>4/12/1862</td>
</tr>
<tr>
<td>9</td>
<td>Tucker</td>
<td>Ebbow Vale</td>
<td>Wales</td>
<td>1/2/1863</td>
</tr>
<tr>
<td>10</td>
<td>Bowen</td>
<td>Norwich</td>
<td>England</td>
<td>19/2/1963</td>
</tr>
</tbody>
</table>

**To Unhide**

i. Select the entire row or column both before and after the hidden row or column.

ii. Go to the **Home** tab and locate the **Cells** group.

iii. Click on **Format** command button.

iv. Select the **Hide & Unhide** option.

v. Select either **Unhide Rows** or **Unhide Columns**.

**NOTE:**
Hiding columns/rows will affect printing.

21. **Adding your Favourite Commands to the Quick Access Toolbar**

i. Right click any command in the Ribbon or Office drop down menu.

ii. Select **Add to Quick Access Toolbar**
Alternatively,

i. Click on the Customize Quick Access Toolbar button at the end of the toolbar

ii. Click on More Commands and use the dialogue box which opens, shown opposite, to add more commands into the box on the right using the Add button.

iii. Click OK

22. Flash Fill

Excel is able to recognize patterns of text. It can predict and prompt text to fill into cells. To see this in action with a couple of name columns:

i. Locate the data you wish to carry this out with (column of first names and a column of surnames) and create a new column in that table.

ii. Enter the full name at the top of the new column for the first record, then start typing the full name for the second record. Excel will recognize the pattern and suggest text to fill into the remaining cells by displaying them in grey.

iii. To accept the suggested text press ENTER on the keyboard.
23. Help When Writing a Formula
When you are writing in the middle of writing a formula and wish to open the dialogue box which helps you
i) Press CTRL+A.
   For example, in a cell type =Sum, then press CTRL+A

24. Format Painter
Format Painter allows you to copy formatting from one cell and apply it to another cell or a range of cells.
i. Click on the cell which has the formatting you wish to copy
ii. Click on the Format Painter button on the toolbar
iii. Click on the cell or drag over a range of cells to apply the formatting

TIP:
If you need to apply the formatting style to many non adjacent cells or ranges, double click on the Format Painter button in step ii. Your mouse will carry on applying the formatting to cells you click or click and drag over until you click on the Format Painter button once more.

25. Create a Style
A style is a collection of formatting features rolled into one command. When you apply a cell style to a cell or range of cells several formatting changes may take place at once.

To Create a New Style
i. Format a cell with all the attributes you wish to add to the style
   ii. Click on the Cell Styles command button (Home tab, Styles group)
   iii. Click on the New Cell Style option located at the bottom of the cell styles gallery. This Style dialogue box as shown below will be displayed.
   iv. In the Style name box type in a descriptive name for your new style
   v. If you wish to add any further formatting attributes at this stage click on the Format button in top right corner of the Style dialogue box. This will display the Format Cells dialogue box. Go to the relevant tab(s) and change the necessary settings.
vi. If necessary, use the checkboxes in the Style dialogue box to switch on/off various formatting attributes.

vii. Click OK

To Apply a Style to a Cell/Range of Cells
1. Select the cell/range of cells
2. Click on the Cell Style command button (Home tab, Styles group)
3. Select the style you require from the cell styles gallery which is displayed.

Any styles you created will be listed at the top of the styles gallery

26. Data Bars Conditional Formatting

Data bars is one type of preset conditional formatting which you can use on a range of cells with numbers. The data bars option graphically represents numbers you have in a specified range in a useful way to show their relative magnitude.

To Apply the Data Bars Conditional Format
i. Select the range of cells
ii. Click on the Conditional Formatting command button (Home tab, Styles group)
iii. Select Data Bars
iv. Select the colour you require

The data bars in the spreadsheet